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T he next General Meeting will be 
at 2 pm Thursday 11 June in the 

Manly Library Room when Bridget 
Mahoney will talk about eBay. You 
will see how millions of eBayers buy 
and sell on this popular online auc-
tion site. Bridget will take us 
through the process of signing up to 
become a registered member. She 
will also take you to PayPal, eBay's 

internet banking site, which manages all 
transactions for both buyer and sellers. 
Beware! Once signed up you may become addicted to online eBay shop-

ping. There will be the usual tea, coffee and biscuits available with Lyn smiling behind the urn and 
the opportunity to talk to Bridget and other tutors and members. 

I n May Bob Bellini entertained us with a talk on what to do about 
failed mail. His PowerPoint presentation contained pictures to 

help us understand exactly what is happening when an email is 
sent and how it reaches its destination or is returned. For exam-
ple, the BigPond server will refuse or return mail for reasons in-
cluding:-No such person with an account at bigpond.com. The re-
cipient’s mail box at the BigPond Post Office is full. The email is 
bigger than BigPond allows, or has disal-
lowed attachments. Your Post Office is on 
a banned list for sending spam. The Big-
Pond server is busy – try again later. It is 
most likely you have spelt the email ad-
dress incorrectly. 

. 

Jack Newton announced 
that the Thursday after-
noon workshops will start 2 
pm Thursday 28 May in the 
Club Room. The first one 
will be Skype Voice (and 
vision) over the Internet. 
The course filled quickly 
but others can add their 
names for the second 
course. Associate mem-
bers are always welcome 
to come to workshops. 

http://www.manlycompals.org.au
mailto:gwyneth@bigpond.net.au
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M ore on WolframAlpha: the next big thing in search? Brian Bergstein 

When a free web service called WolframAlpha launches in the coming days, the general public will get to 
try a "computational knowledge engine" that has had technology insiders buzzing because of its oracle-

like ability to spit out answers and make calculations. 

Which has a bigger gross domestic product, Spain or Canada? What was New York City's population in 1900? When 
did the sun rise in Los Angeles on November 15, 1973? How far is the moon right now? If I eat an apple and an 
orange, how much protein would I get? 
WolframAlpha will tell you - without making you comb through links as a search engine would. It also will graphi-
cally illustrate answers when merited. So if you query "GDP Spain Canada" you'd see a chart indicating that 
Spain's economy was smaller than Canada's most of the time since 1970 and recently pulled ahead. That's pretty 
clever. 
Yet after testing the service for a few weeks, I think WolframAlpha is unlikely to become a household name. 
While WolframAlpha is brilliant at times and elegant in its display, there aren't many ways everyday web users 
would benefit from using it over other resources. 
For all the fears that Google is making us stupid by making it too easy to look up information, at least Google and 
its rivals enable the critical thinking that comes from scoping out multiple sources. 

The site does suggest ways to track down similar information from other sources, including government statistics, 
proprietary databases, almanacs and the collaborative encyclopaedia Wikipedia. To confirm WolframAlpha's data 
I went a suddenly old-fashioned route - through web searches on Google and Yahoo. I didn't find any errors, but 
taking that step made me wonder why I didn't just use Google or Yahoo to begin with. 

WolframAlpha comes from Stephen Wolfram, 49, a British-born physics prodigy who earned a Caltech Ph.D. at 
age 20 and won a MacArthur Foundation "genius grant" at 21. Wolfram went on to focus on complexity theory, 
especially the idea that patterns in nature could emerge from simple rules, and founded Wolfram Research, 
which develops advanced math and analysis software called Mathematica. Because Mathematica includes data 
"curated" by more than 100 Wolfram employees, over the years the company has built a wide knowledge base. 
Now WolframAlpha lets the wider world have a crack at it. 
The amount of data in the service is impressive. It can show the odds of lottery games in any state. By tapping 
birth stats and mortality data it estimates there are 2.8 million people named William alive in the U.S. today. It 
knows The Big Lebowski earned $US17 million at the box office. 

But often WolframAlpha can be unacceptably nerdy. When I sought the distance from Boston to Philadelphia, the 
site told me 265.4 miles. And then it had to be a showoff. It also said the journey is 427.1 kilometers, 427,070 
metres, 4.271 times 10 to the 7th power centimeters or 230.6 nautical miles. And that an airplane could travel 
that distance in 28.9 minutes, sound could do it in 20.9 minutes, light in fibre would need 2 milliseconds and 
light in a vacuum would need 1.42 milliseconds. That's even 
before I clicked on "more" to see how 
long the trip would be for a ship at 25 
knots or a car at 55 mph. 
At least initially, WolframAlpha 
probably will appeal most to techni-
cal specialists - people who make 
calculations based on how many ver-
tices are on a great rhombic triacon-
tahedron (182) or what gene is 456 
base pairs upstream of another given 
gene. 

For most other people, WolframAlpha 
won't provide aha-wow moments that mark 
true game-changers. 

AP  
This story was found at: http://www.smh.com.au/s/2009cles/2009/05/14/1241894098345.html arti-
cles/2009/05/14/1241894098345.html 

http://www.smh.com.au/s/2009cles/2009/05/14/1241894098345.html
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H ow to find out what version of a program you're using.  To find out what version of software, 

browser, email, etc., that you are using you can almost always do this: 

Open the program and click "Help" "About". Some programs will show the version number, your registration informa-
tion, the developer's name or company and a contact or Web site address. Cloudeight 

 

A dding Borders to Text Word allows you to quickly and easily add borders to selected text in 

your documents. Normally, you would add borders to entire paragraphs to make them stand out from surround-
ing text. However, if you are using Word 97 or later, you can also add borders to specific text within a paragraph. 
Simply follow these steps: 

1. Select the text that you want bordered. 

2. Select the Borders and Shading option from the Format menu. You will see the Borders and Shading dialog box. 
(Notice that Text is already specified in the Apply To drop-down list.) 

3. Use one of the preset boxes available in the dialog box, according to your desires. 

4. If you want a custom border, select the Custom option from the Setting box. Then, you can control the border 
by clicking on the line buttons located in the Preview box. 

5. Select a line type from the Style list. 

6. To adjust the distance the borders of the box will be from the paragraph text, click on the options button to 
get the From text options. 

7. Change any of the From text distances, clicking OK when done. 

8. Click on OK to close the Borders and Shading dialog box. 

Tip #604 applies to Microsoft Word versions: 97 | 2000 | 2002 | 2003 Word.Tips.Net 

 

U nderstanding MRU Files MRU is an acronym for most recently used. It describes a feature of Word that 

allows you to quickly open your most recently used documents. These file names are displayed by Word at the 
bottom of the File menu. 

When you first install Word, it displays the four most recently used documents in the MRU list. If you want to change 
the number of documents remembered by Word for the MRU list, you can 
do so by following these steps: 

1. Choose Options from the Tools menu. This displays the Options dialog 
box. 

2. Click on the General tab.  

3. Make sure the Recently Used File List check box is selected. (If it is 
not selected, then no MRU files are maintained by Word.) 

4. For the Entries value, specify a value between 1 and 9. This signifies 
how many MRU files should be remembered by Word. 

5. Click on the OK button. 

Tip #131 applies to Microsoft Word versions: 97 | 2000 | 2002 | 2003 Word-
Tips 

 

B roadband tip Marilee's tip: This is just basic info with people who use broadband. I work in Technical Sup-

port for an ISP and the top calls we receive are for people who say they cannot connect to the internet. 99% of 
the time, all that is needed is to unplug the modem for about 10 seconds and plug it back in - and that usually will 
take care of the issue. 

If using a router, unplug the modem and router. There are many reasons why a system will lose sync, power surge, 
etc., but try this first before taking the time to call your ISP. Modems will have certain light patterns when you are 
connected. Getting familiar with those will save you time and a few headaches. Make sure the modem is getting 
power, if the PC light is off, check the Ethernet cord, if the cable light is out, check the coax cord to see if it se-
curely in the modem. These are very simple tips but regrettably, most ISPs will not tell you this until you have to 
call. Hope you can share this sometime. Cloudeight 
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E leven computer tips you can use every day 
All Windows Users 
1. Change computer time: Right mouse click on the clock in your system tray (lower far right) or right click 
in system tray and choose "adjust date and time". 

2. To save a picture/image from a web page, right mouse click and choose "Save Picture As". You can rename it 
at this time too. 

3. To see how much hard drive/hard disk space you have left, do this: Double click My Computer, right mouse 
click on your C drive (or any hard drive) and chose properties. 

4. Most common image formats are JPG, GIF, BMP and PNG. Most common image format exported from a digital 
camera is a JPG. 

5. If you accidently delete a file, click Control key + Z to bring it back instantly. You can also look in your recy-
cle bin if you don't realize it until later, then just right click on the file and choose "restore" and it will go 
back to where it came from. 

6. If you hold the shift key down when deleting a file, it bypasses the recycle bin. Control Z will still bring it 
back. 

7. If you occasionally see a red X instead of an image on a web page, it is not a setting problem with your 
browser. It usually means the webmaster who made the page put in a bad link. 

8. F1 key opens Windows Help quickly! 
9. You can quickly maximize a window by double clicking the title bar of the window... this is the big long blue 

area at the top of your window. Double click again to bring it back to the size it was prior to maximizing. 
10. Alphabetize the items in your start menu by clicking Start, Programs, and while hovering over any program, 

right mouse click and choose Sort by Name. 

11. Quick View of your System: If you hold the Alt key down while double clicking My Computer, it will open Sys-
tem Properties Window. This is where you can find your computer's name, system restore, auto updates, 
hardware, and more. The first screen "general" will show you a lot of information about your system such as 
what version of Windows you are using, who the computer is registered to, how fast your CPU is and how 
much RAM you have. Cloudeight 

 

And more 

T he Anti-Shutdown Shortcut Windows XP.   Have you ever clicked "Shutdown" and realized you forgot to save 

something or wanted to finish something before you shut down, and it was too late? And you sure don't want to 
wait for it to shut down then have to re-start Windows all over again - because you’re already late for dinner. 
You can put a shortcut on your desktop - so the next time you click "Shutdown" and your computer starts tumbling 
toward oblivion, you can stop the shutdown process, finish what you need to finish, and then shutdown. Sound 
good? OK! Here's what you need to do to create the Anti-Shutdown shortcut on your desktop. 

1. Right-click an empty space on your desktop 
2. Select the option "new shortcut" 

3. Type "shutdown -a" (Exactly as shown but without the quotes.) 
4. Click next 

5. Type a name for the shortcut (e.g. Anti shutdown) and click finish 
When you're all done you can leave the shortcut on your desktop or drag it into to your Quick Launch toolbar or your 
Start Menu. 

 

W indows Explorer Tip  Microsoft’s Windows Explorer file management program is virtually indispensable for 

finding, viewing, copying, deleting files on computers running Vista, XP and other 
Microsoft operating systems.  Windows Explorer may be accessed through Programs - Acces-
sories – Windows Explorer or by putting a shortcut on the Windows desktop.  However, the 
easiest way to access it is simply by holding down the Windows Key on the keyboard – it’s 
the one between the Ctrl and Alt keys and it has a Windows flag on it – and then tapping 
the letter ‘e’. 
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F ont lovers rejoice! Fonts are a lot easier to manage in Windows 7. Folks who love fonts know that Windows has 

not always been so kind to font lovers. Windows 7 offers more default fonts than any previous version of Win-
dows. 

First, if you're running Windows 7 beta - or if you're saving this until you get Windows 7 - you'll be happy to know that 
Windows offers an easier way to work with your fonts - and a much better way to see what the fonts you have actually 
look like. To access the font folder in Windows 7 - click Start, Control Panel, Fonts. From here you can now preview, 
delete, show or hide all the fonts installed on your system. 
You can adjust ClearType text here too; on prior versions of Windows you had to download a utility or go online to 
adjust ClearType. ClearType improves readability of text on LCD screens making text more readable on your computer 
screen -- almost as sharp and clear as those printed on paper. 

Character Map can be found here also.  The Character Map utility has been included right along on all Windows sys-
tems and is used to copy and paste accented letters, foreign language characters and symbols into any Windows appli-
cation. Other commands found in the fonts dialog are Set custom Text Size (make it easier to read what is on your 
screen), and more general font information. Cloudeight 

 

W ebsite for bookworms ready to roll 
Lara Sinclair AustralianIT. 

Former Southern Cross Broadcasting and Nine Network executive Kim Anderson has 
teamed up with internet entrepreneur Luke Carruthers to launch a social media 
venture that takes on two of the giants of the digital world. 
The Reading Room -- a social media website for book lovers -- will go into public 
testing, coinciding with a promotional campaign to launch the site at the Sydney 
Writers' Festival. The site will compete with social media behemoth Facebook for 
friend referrals and recommendations among readers, and with global e-tailer 
Amazon for sales, but with a single-minded focus on avid readers. 

"We're creating a community for readers to live on and share books with each other and 
share their thoughts about reading", Ms Anderson said. 
The site is designed around a virtual "bookshelf", on which members can put books selected from a comprehensive 
global database containing 4 million different titles and editions, covering a wide variety of genres from fiction to 
academic texts. 
They can then rate, recommend and share their views on books, as well as form and join virtual book groups to discuss 
them. 

While members will not at this stage be able to read books on the site, they will be able to buy books. 
"You can rate a book", Ms Anderson said. "You can make those books available to be viewed by other users. 

"You can also buy books." 
Mr Carruthers, who has previously started technology firms including Magna Data and InterTouch, said the social na-
ture of the site was the key. 

"The whole idea of users and members talking to each other is what the site is about", he said. 
Ms Anderson said it was important that The Reading Room, which she jointly owns with Mr Carruthers, remained inde-
pendent but had links to the world's key publishers. 

She said rival social networking sites for readers were generally linked with a particular publisher, a factor that led 
members to question the independence of book recommendations and reviews. 

Once The Reading Room is established in Australia, the pair intend to launch it in the US -- hence a global web do-
main, www.thereadingroom.com  
The plan is to make money from online advertising, mainly from publishers promoting new titles, as well as by charg-
ing a commission on book sales. 

There is also the potential to conduct market research among readers once the site reaches critical mass. 
Media company Full Circle is in talks to represent the site for advertising sales. 

The founders are hoping more than 250,000 members will join up in the site's initial phase. 
AustralianIT 

http://www.thereadingroom.com
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A  Useful Website – www.pcdon.com  All Computerpals members whether expert or novice should find the web-

site www.pcdon.com invaluable.  It has solutions to problems ranging from adding attachments to emails to using 
the msconfig command to speed up a computer. 
The website is run by a Californian, Donald Edrington (pictured), who bought his first computer, a TRS-80 Model I with 

4 KB of RAM in 1977. Since 1984, Don, aged 77, has specialised in helping seniors who are 
new to computers. Don is the PC Columnist for The Californian & San Diego’s North County 
Times. 
As well as providing ‘how-to-do-it’ articles, the site provides a wealth of music tracks 
which can be downloaded and listened to while you browse the site.  For the nostalgia 
buff, www.pcdon.com is a goldmine. The big bands of the 30s, the singers of the 40s and 
50s are there to transport you back to a different non-digital world.                                                         
JN – Rev. May 2009 
 

T his was sent from Thomas Cook Holidays - listing some of the guests' complaints during the season. 

(Survey by Thos Cook and ABTA)    

“I think it should be explained in the brochure that the local store does not sell proper biscuits like custard creams or 
ginger nuts."    
"It's lazy of the local shopkeepers to close in the afternoons. I often needed to buy things during 'siesta' time - this 
should be banned."    

"On my holiday to Goa in India, I was disgusted to find that almost every restaurant served curry. I don't like spicy food 
at all."      

"We booked an excursion to a water park but no-one told us we had to bring our swimming costumes and towels."    
A tourist at a top African game lodge overlooking a waterhole, who spotted a visibly aroused elephant, complained 
that the sight of this rampant beast ruined his honeymoon by making him feel "inadequate".    

A woman threatened to call police after claiming that she'd been locked in by staff when, in fact, she had mistaken 
the "do not disturb" sign on the back of the door as a warning to remain in the room.    
"The beach was too sandy."      

"We found the sand was not like the sand in the brochure. Your brochure shows the sand as yellow but it was white."       
A guest at a Novotel in Australia complained his soup was too thick and strong. He was inadvertently slurping the gravy 
at the time.    
"Topless sunbathing on the beach should be banned. The holiday was ruined as my husband spent all day looking at 
other women."      

"We bought 'Ray-Ban' sunglasses for five Euros (£3.50) from a street trader, only to find out they were fake."    
"No-one told us there would be fish in the sea. The children were startled."  

"It took us nine hours to fly home from Jamaica to England it only took the Americans three hours to get home."    
"I compared the size of our one-bedroom apartment to our friends' three-bedroom apartment and ours was signifi-
cantly smaller."    

"The brochure stated: 'No hairdressers at the accommodation'. We're trainee hairdressers - will we be OK staying 
here?"    
"There are too many Spanish people. The receptionist speaks Spanish. The food is Spanish. Too many foreigners."    

"We had to queue outside with no air conditioning."    
"It is your duty as a tour operator to advise us of noisy or unruly guests before we travel."    

"I was bitten by a mosquito - no-one said they could bite."    
"My fiancé and I booked a twin-bedded room but we were placed in a double-bedded room. We now hold you responsi-
ble for the fact that I find myself pregnant. This would not have happened if you had put us in the room that we 
booked." 
 

I f you are going to UK and intend to travel by train you can save a lot of money by using Rovers & Rangers. All 

the various options are on the National Rail Enquiries website www.nationalrail.co.uk  Click on Train Times & Fares, 
then Special Offers, then Rovers & Rangers. Use thetrainline.com for price comparisons if just wanting a single or re-
turn between two destinations. 

http://www.pcdon.com
http://www.pcdon.com
http://www.pcdon.com
http://www.nationalrail.co.uk
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Program  ~  Members’ ForumProgram  ~  Members’ Forum  
9 June 20099 June 2009  

Level 1, 280 Pitt Street, SydneyLevel 1, 280 Pitt Street, Sydney  
10.00 am 10.00 am ––  2.00 pm2.00 pm  

  
ALL CLUB MEMBERS ARE WELCOME 

  

 

RSVP TO office@ascca.org.au  by 5 June to help with catering please 

10.00 am  Welcome – roll call 

   
10.10 am  National e-Security Awareness Week 

 Speaker from Australian Federal Police AFP 

 
10.50 am  Apple Macs Apple Macs ––  David BennettDavid Bennett 

   
11.30 am  Report on Videoblog Workshop with Jay Dedman and  Ry-

anne  Hodson - Sirkka Duncan & Tony Lenn 

12.00 pm   Lunch 

  
12.30 pm Tim    A Simple Interface for the Novice PC User 

  Tim Connell, Managing Director, Quantum Technology 
   

1.00 pm   Panel:  Clubs speak out! 

  Meetings & Speakers - Diane Brentnall 

  Community Courses   - Deborah Martin 

  Short Courses             - Ron Hare [tbc] 

1.45 pm   Questions from the floor! 

  
2.00 pm   Close 

  

mailto:office@ascca.org.au
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Monday 
9 am – 1 pm 

1 pm – 5 pm 

Dorothy Peters & Lyn Nicholls  

David McAdam & Arthur Johnson 

Tuesday 
9 am – 1 pm 

1 pm – 5 pm 

Philip Bowtel & Wally Gora 

Lyall McNeish & Harry Brabin 

Wednesday 
9 am – 1 pm 

1 pm – 5 pm 

Ted Hulbert & Bridget Mahoney 

Harry Aguero & Elaine Johns 

Thursday 
9 am – 1 pm 

1 pm – 5 pm 

Dorothy Peters & Elaine Clarke 

Workshops 

Friday 
9 am – 1 pm 

1 pm – 5 pm 

Ern Cohen & Hugh Walker 

Bob Bellini  

Tutors’ Roster (subject to change) 

Welcome to new members  
Anne CALCRAFT; Albert CATLIN; 
Myriam MARADEI; Paul MATHIESON; 
Roslyn REES; Frank ROPERTI; Yvonne 
WALSH; Alice WILSON. 
If you are not mentioned here you 
will be next month. 

The assistance provided by Manly Council to 
Manly Computerpals is gratefully acknowl-
edged. 

Our Website is kept up to date by Graham  
and includes photos, latest news and recent  
and former copies of the Manly Mouse. 

IF YOU CANNOT ATTEND A CLASS PLEASE 
PHONE THE CLUB 9976 0930 AND ADVISE THE 
DUTY TUTOR TO ALTER LIST. 

Disclaimers  
Members who bring  equipment such as a laptop computer or digital camera to the Club, do so at their own risk and Com-
puterpals accepts no responsibility for damages or loss. 
Each reader of the Manly Mouse newsletter assumes complete risk as to the accuracy and subsequent use of its contents.  
This newsletter is provided “As Is” without warranty of any kind. 

T utor skills. An updated list of tutor 

skills is now on the noticeboard in the 
Club Room. So, having learned basic skills if 
you now want to learn a particular skill 
then look on the noticeboard to see which 
tutor can help you. 

S pecial Courses (Workshop) Survey.   Members’ re-

sponse to preferences in special courses survey was 
most encouraging. Leading the preferred courses was 
that of tweaking Windows Vista & XP to get them to run 
faster and more hassle-free.  Runners-up included VoIP 
and Digital Photography. The next phase, involving pre-
paring a plan of workshops on the topics members wish 
to attend, is already underway and the first workshop 
on Skype (a VoIP program) has been scheduled for 28 
May. 
It is intended that the plan will include full details of 
each workshop — its presenters, details of any prerequi-
sites, where and when it will be held, its cost and de-
tails of how to register for it. 
It is expected that the draft workshop plan will be com-
pleted in the next few weeks and members will be noti-
fied on the plan’s progress via the Club noticeboard and 
the Manly Mouse. The plan’s timeframe will extend up 
until the December close down. 
It is intended that in offering specialised workshops 
members will gain additional benefits from being be able 
to use a computer as an aid in pursuing interests in such 
diverse activities as photography, music, shopping and 
so forth. 


